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Chapter 1

Getting started

To start the program type ./EventDisplay or ./EventDisplay myDSTfile.root
and hit Return. The latter will start the program and open the file 'myDST-
file.root’. If no file was loaded you see the programs blank starting screen:

»

L)

Figure 1.1: Blank starting screen

1.1 Opening a file

To open a mDST file go to the 'File’ menu and select 'Open’. A file dialog will
show up and lets you select the designated mDST file from your file system.
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Figure 1.2: Opening a file

Once a file is selected, klicking on ’Open’ or hitting Return will open the file
in the Event Display.
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Overview and basic
functions

On opening a mDST file the program shows the first event in the central Viewer
Widget in a Top/Down perspective (more on perspectives in section 4). The
current detector setup is displayed in the Setup Widget while detailed event
information is shown in the Particles Widget. The Navigator Widget is ini-
tially empty and will be discussed later on since it is one of the Event Displays
advanced functionalities.

Viewer Widget

A s 3

Setup Widget

Navigator
4 Widget

Particles Widget

Figure 2.1: Widget overview

2.1 Displaying a specific event

To display a specific event just type the number of the event (zero based) in the
Event Selector Toolbar right above the Viewer Widget or use the various skip
buttons as described in Figure 2.2.
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Figure 2.2: The Event Selector Toolbar

In this context skipping 10% of all events means that if the mDST file con-
tains 1000 events, 100 events will be skipped.

2.2 Customizing views: The Viewer Widget

There are five predefined modes called Perspectives for the Viewer Widget avail-
able in the 'View’ menu:

One viewer perspective

Windows » Top/Side perspective
Toolbars L4 Four viewers perspective

Calorimeter cluster energy perspective

Track detectors perspective

Figure 2.3: Perspectives

A Perspective defines a set of sub-viewers with a preset of displaying prop-
erties such as the projection mode (orthographic/perspective/planar) or the
projection angle. Once one of the sub-viewers is activated by left-clicking any-
where in its drawing area, the viewers frame color turns from green to red and
the Viewer toolbar becomes operational.

‘ Zoom lRolale] Select Ruler

(a) Control Toolbar
Figure 2.4: The Control and Viewer toolbars
The Control toolbar The Control toolbar provides three modes of operation
for the mouse when used in a viewer:
e Zoom
e Rotate
e Select

In Zoom mode you can perform a rubber-band zoom on a designated section by
clicking and holding the left button while dragging the mouse. In Rotate mode
clicking and holding the left mouse button while moving the mouse rotates the
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entire geometry (does not work in planar projections). In Select mode hovering
with the mouse over a detector element will highlight it in the viewer as well
as in the Setup Widget, while hovering over a track will highlight the track in
the viewer and the associated particle in the Particles Widget. Zooming via the
mousewheel and panning by clicking and holding the middle mouse button is
available in all modes.

Additionally the Control toolbar has a 'Ruler’ checkbutton which activates
or deactivates a set of rulers to measure distances. These are very useful in
planar projection mode.

The Viewer toolbar In the Viewer toolbar you can select one of three pro-
jection modes per viewer:

e Orthographic
e Perspective
e Planar

where the most common projection used is the Planar mode. The different
projections are detailed in section 4.

The buttons Side, Top and Front allow to switch the active viewer to either
a side-, top- or front view of the entire geometry. By pressing Home the initial
view of the current Perspective is restored.

The spinbox to the right is only active in Planar mode. The angle of the
projection plane can be entered there directly or adjusted either by the arrow
buttons or by using the beforementioned Side or Top button.

The Link button is intented to link all viewers for which it is toggled in
such a way, that they are affected concurrently by translation, rotation and
zoom. Note that the Link functionality is still under development and not fully
operational yet!

The buttons Lock and Cont.Update are only available in the debug version
supplied during development of the program and therefore not described here.

2.3 The Setup widget

The setup widget controls the appearance of the detector geometry in the visu-
alization process. A main feature is a slider that controls the transparency of
the entire setup geometry.
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Figure 2.5: The Setup Widget

All components of the setup are arranged in a tree-like structure in 5 classes.
Every item in this tree is assigned to a visibility checkbox and a specific color.
Unchecking the visibility or changing the color of a certain item will propagate
downwards through the tree.

2.3.1 Creating new groups in the detector tree

If you want to arrange the detectors in a custom way, yo may want to insert
your own group nodes into the tree. E.g. if you want to add a group node
"Electromagnetic’ to the ’Calorimeters’ node and add ECAL1 (EC01P1__) and
ECAL2 (EC02P1_.) to this group, right click into the ’Calorimeters’ node and
choose ’add group’ in the upcoming context menu (see fig. 2.6). A dialog box
will ask for the name of the new group. Once entered, the new node will appear
as a child node of the 'Calorimeters’ node. You can now move the two detectors
to this group via drag and drop.

Load configuration

Save configuration

Create new group...

Delete Group

Figure 2.6: Adding group nodes

2.3.2 Deleting groups

If a group is empty, you can delete it by right-clicking on the group and selecting
"Delete Group’ in the context menu.
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2.3.3 Saving a custom configuration

If you have customized the setup to your needs and want to reuse this config-
uration (color scheme, visibility, detector arrangement) for another mDST file
you can save it to an XML file by right-clicking anywhere in the setup widget
and selecting ’Save configuration’ in the context menu. A file dialog will show
up and ask you where to save the configuration file.

2.3.4 Reloading a saved configuration

If you want to reuse a previously saved configuration (see section 2.3.3), right-
click anywhere in the setup widget and select 'Load configuration’ in the context
menu. Locate the XML file that you saved before and open it. There are
also some more predifined configuration files with different color schemes and
detector arrangements available. Notice that reusing custom configurations may
not work correctly if the setup has changed.

2.4 The Particles widget

The Particles widget shows detailled information on identified particles. Select-
ing a particle in the widget will highlight the associated track in the viewer
widget if existent. Particles that have no associated vertex are greyed out and
are only displayed if the entry ’Show only physical Tracks’ in the ’Options’ menu
is not checked.

Partides

Index (3 Color Charge Momentum Richinfo? Type W Paricle Type Verices CaloRefs Beam? MuPrim? ZFist  Zlast  Length  NHits ChiZTot MeanTime

351004 yes 1 UNKNOWN 1 0 no no 140901 554737 413.837 38  430.195 5.02701
19801 yes ackground . UNKNOWN 1 0 no no 140901 554737 413.837 41 118593 -4.83975

Figure 2.7: The Particles widget

2.5 The Events widget

The Events widget shows as well detailled information about the currently
loaded event as a history of all events that were viewed in the actual session.
Each time you view a new event it will be inserted into the list. Selecting a line
here will reload the associated event.
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Events E®
Index  Run  Spill Event Particles Tracks Verices Cal.Clust. Trigger Accepted  Monitor
0 57022 1 94 12 29 1 57 1073742080  yes no
74 57022 1 2804 4 H 1 41 1073741825  yes no
148 57022 1 5294 8 10 3 46 1073741825  yes no
222 57022 1 7974 4 73 1 35 1073742088  yes no
296 57022 1 10654 7 14 5 38 1073741829  yes no
370 57022 1 12954 7 E] 3 38 1073741825  yes no
1 5624 6 2 1073742080
518 57022 1 17914 8 10 1 37 1073741825  yes no
592 57022 1 20714 7 10 4 30 1073741823 yes yes
666 57022 1 23174 6 29 2 32 1073741832 yes no
740 57022 1 25464 1 24 12 65 1073741844  yes no

Figure 2.8: The Events widget

2.6 The Navigator widget

The Navigator widget will be discussed in section 5.
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Customizing the programs
appearance

Except the viewer widget and the menu bar all widgets and toolbars can be rear-
ranged in position or completely hidden to meet your visualization or handling
demands.

3.1 Showing / hiding toolbars and widgets

To hide or show a specific widget or toolbar go to the 'View’ menu and select
"Windows’ or "Toolbars’:

Perspectives #

~ Setup

Toolbars Ewvents

<+ Particles

~ Mavwigator

(a) Widgets

Figure 3.1: Setting visibility of widgets and toolbars

The visibility of a certain item is indicated by check marks and can be toggled
by selecting the items menu entry. Alternatively, widgets can be hidden using
their 'Close’-Button (see fig. 3.2).

10
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Figure 3.2: Widget buttons

3.2 Rearranging toolbars and widgets

Initially, all toolbars and widgets are ’docked’ to the programs GUI. You can
undock and re-dock them to another position in the GUI or leave them undocked
as single windows that can be positioned anywhere on your desktop. This can
be very useful if you have multiple displays, so you can put the main program
window with the maximized viewer widget on one display and the controls on
the other.

Undocking toolbars To undock a toolbar left-click and hold the mouse in
the shaded area at the left (see fig 3.3). The mousepointer will turn into a cross
of arrows and you can drag the toolbar around.

/[ Zoom l Fimatel Select Ruler
shaded area

Figure 3.3: Undocking toolbars

Re-docking toolbars To re-dock a toolbar drag it to its designated position
near the inner borders of the main program window. The other widgets and
toolbars there will automatically move and leave a space where you can drop
the toolbar.

Undocking widgets To undock a widget left-click and hold the mouse in the
header area at the top or click the widgets 'Dock / Undock’-button (see fig.
3.2). Now you can move the widget around and use it as a single window or
re-dock it to another position in the GUI.

Re-docking widgets The procedure is equal to re-docking toolbars except
one special feature: When dropping one widget onto another, the two widgets
merge into a single, but tabbed’ widget. Clicking on a certain tab will bring
one widget up to the front and put the other in the background and vice-versa.
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Event visualization

As mentioned before, there are five predefined visualization modes called per-
spectives available in the view menu. We will now explain them in detail:

Figure 4.1: Perspective projection

12
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4.1 The ’One Viewer Perspective’

This perspective starts with a perspective projection of the setup, but it is
fully customizable as described ind section 2.2. It is designed to maximize the
visualization area of the setup and is therefore the dedicated perspective to
export graphics for publications or presentations (more on exporting graphics
in section 5.2). Fig. 4.1 shows a rotated perspective rotation, while fig. 4.2
shows a zoomed planar projection of the target area with activated rulers:

Figure 4.2: Zoomed target area with rulers
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4.2 The *Top/Side perspective’

This perspectives shows to planar projections of the setup, one with 90° pro-
jection angle (top view) and one with 0° projection angle (side view). The top
view shows the deflection of charged particles, while scattering angles in the
Y-Z plane can be observed in the side view:

Figure 4.3: Top/Side perspective
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4.3 The ’Four Viewer Perspective’

This perspectives shows three planar projections of the setup, one from the side,
one from the top and one from the front. The fourth viewer shows a perspective

‘overview’ projection:

Figure 4.4: Four viewers
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4.4 The ’Calorimeter cluster energy perspective’

This perspective consisty of one viewer in planar projection and one ortho-
graphic front view for each calorimeter in the setup. Energy deposits in the
calorimeter cells are shown as a color gradient from black (low energy) to white
(high energy). Tracks are also shown in the viewers for the calorimeters. Fig
shows an example of this this perspective with HCAL1, ECAL1, HCAL2 and

ECAL2:

Figure 4.5: Calorimeter energy deposits
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4.5 The 'Track detectors perspective’

This perspective consists of two viewers, both in planar mode. The upper viewer
shows setup and tracks, the lower one is initially empty except the beam axis.
When a particle is selected in the particles widget (section 2.4), the associated
track is highlighted in the upper viewer and the lower viewer shows this track
and only those tracking detectors whose hits contributed to the reconstruction
of this track. Fig. 4.6 shows a highlighted track and the belonging detectors.

Figure 4.6: Track reconstruction
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Advanced functions

5.1 The Navigator widget

The navigator widget is a tool that helps the user browsing large datasets, find-
ing interesting subsets or outlieres in the data and reveals the overall structure
of the dataset. It is based upon our novel 'EventMap’ approach for visualiza-
tion in HEP. The key idea here is to define a distance metric on events and then
calulate a 2D map representation of the events in a mDST file which preserves
these distances best. The workflow here is as follows: Starting with an overview
map created from a subset of all events, one can iteratively select an event at a
point of interest and define a radius around it to create a new, more detailled
map (immersion). To create the overview select 'Update navigator’ from the
"Navigator’ menu. A dialog box will appear and ask you to enter the size of the
event subset for the overview map and the underlying ground distance for the
distance metric (see fig. 5.1).

Update Mavigator

Change options...

Cluster dialog...

(a) Menu entry

Figure 5.1: Setting up the Event Map
A number of samples of about 500-1000 shows the best results. When you
select "Accept’ in the dialog box, the overview map will be computed. This may

take a while, dependent on the map size. When the computation is finished,
the map will be presented in the navigator widget:

18
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Figure 5.2: Navigator widget / overview map

Every point in this map represents a specific event. If you are in selection
mode (default), clicking a point on the map will display the event in the current
viewer widget. To define a radius around an event of your interest, click the
'immerse’ button (see fig. 5.2). Then move the mouse to the designated event-
point on the map, click and hold the left mouse button to drag a circle around
the event (see fig. 5.3). Releasing the mouse button starts the computation of
the new map. Zooming into the map without recalculation is also possible: The
'zoom’ button (see fig. 5.2) switches to a rubber-band zooming mode while the
'show all’ button reverses this operation. If you want to get back to the initial

overview map, just hit the ’home’ button.

[©]
®

Navigator

FAoe
S
(=]

Ready.

Figure 5.3: EventMap immersion radius

Since the projection of the high dimensional ’event space’ on a 2D map
does not preserve all original distances, the radius defined around an event
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may contain more or less events then the circle in the overview map would let
us expect. This displacement of points during the projection is called stress.
Initially the events are colored by a per-point-stress value, where green means
'no stress’, yellow ‘'medium stress’ and red "highest stress’. There are four modes
of stress compensation available in a drop-down menu of the navigator widget
(see fig. 5.2):

e Plain - no stress compensation
e BortStress - weight radius with inverse of point stress function

e MaxDelta - radius is maximum of original distance from center event to
all events inside the circle

e BortStress * MaxDelta - combination of the two previous modes

Which compensation is the best for your needs is dependent on the dataset and
region. Very dense regions for example often need no compensation, while very
sparse regions are best explored using 'MaxDelta’ compensation.

If you immersed to maximum depth (see fig. 5.4) the event map becomes
sparse and neigboring events are very similar. The event that was the center in
the previous map is now marked blue.

[©]
®

Navigator

l#][#] @

L

Ready.

Figure 5.4: Maximum depth immersion

5.1.1 Enhancing EventMap results: Preclustering data

Most of the experimental data in mDST files is clustered as you can see in the
screenshots above. Some of these clusters are visible in the 2D map representa-
tion, others may got lost during projection. So the program offers pre-projection
clustering in the high-dimensional event space and lets you explore these clusters
seperately. Since the clustering procedure is computational expensive it may be
performed seperately after creating the overview map by selecting ’Cluster di-
alog’ in the 'Navigator’ menu. In the dialog box the number of clusters has to
be specified (values between 3 and 8 are reasonable). When the cluster compu-
tation has finished you can set the brushing mode from ’Stress’ to 'Cluster’ in
the dropdown box in the navigator widget (see fig. 5.2).
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Figure 5.5: Overview map brushed by clusters

Fig. 5.5 shows the overview map brushed by cluster membership. The
number of clusters is 5 here. To explore a specific cluster, hit the ’cluster
exploration’ button (see fig. 5.2) and click on an event in the color of the
cluster of your interest. A new map will be computed, containing only events
belonging to this cluster (see fig. 5.6). Based on this map you can start further
exploration as described in the previous section.

®
®

Navigator

L)

&/w [z [2]l7

Figure 5.6: Single cluster map

5.2 Graphics export

To export graphics of an event visualization, activate the viewer with the desired
scene and go to the 'File’ menu. The "Export...” submenu (see fig. 5.7) offers
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four graphics formats:
e Postscript (PS)
e Encapsulated Postscript (EPS)
e Portable Document Format (PDF)

e Scalable Vector Graphics (SVG)

Postscript (PS)

Quit

Encapsulated Postscript (EPS)
Portable Document Format (PDF)

Scalable Vector Graphics (SVG)

Figure 5.7: Export menu

22

Selecting one of these entries will bring up a file dialog where you can specify

filename and location:

Export to Portable Document Format (=]
(el [DlhumefblvenmeSTs :] R |
[l compurer Name Size v Type Date Moc
biven

ol I D)
File name [evenLlZid ] [ Hgave l
Files of type, [Puname Document Format (*.pdfi :H b Can(ell

Figure 5.8: Export file dialog
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